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WHY DO WE HAVE  
BR AND GUIDELINES?
Kaivac’s brand guidelines were developed to:

• Provide the foundation of the Kaivac brand

 •  Establish an overall brand essence that should be a part  
of everything we do

  •  Define who we are, how we speak and how we look

  •  Guide consistent execution of our brand — effectively  
and consistently at every touchpoint

Please refer to this guide often to ensure all assets, 
materials and messaging stay true to Kaivac.

CONTENTS



BR AND OVERVIEW



VISION
Kaivac will be the World Leader in creating complete  
cleaning systems that produce healthy results (outcomes).

MISSION
Starting with the restroom, Kaivac will innovate, market,  
and train scientifically proven cleaning systems that:

•  Are functionally and economically “better, faster, and cheaper” 
•  Are environmentally “lean, green, and mean (on soils)” 
•   Raise the value of the cleaning industry and the dignity of the worker
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VISION AND MISSION



We make innovative, reliable, and complete  
cleaning systems for all types of businesses. 

Make the world a cleaner,  
healthier place.

Our systems are scientifically proven to deliver  
a faster, better, and deeper clean than traditional  
cleaning protocols. 

We elevate the dignity and morale of the cleaning  
professional with worker-inspired ergonomic designs  
that make cleaning easier and reduce exposure to  
harmful germs and chemicals.
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THE GOLDEN BULL SEYE



For the commercial cleaning industry,  

Kaivac is the one cleaning system that delivers a 

deeper, faster and more cost-effective solution 

than traditional cleaning protocols. Unlike the competition,  

Kaivac uses worker-inspired product innovation to find better ways 

to clean, while leveraging science and technology 

to prove its effectiveness.   

TARGET AUDIENCE

CATEGORY

KEY CUSTOMER BENEFITS

COMPETITIVE DIFFERENCES

BRAND
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POSITIONING STATEMENT



U N I Q U E  A T T R I B U T E S
 

Innovative /  Scientifically-Proven / Value-Driven / Environmentally Responsible / Champion of the Worker / Easy-to-Use

B R A N D  P E R S O N A L I T Y
 

Compassionate / Trustworthy / Determined / Helpful / Disruptive / Friendly / Wise / Humorous

E M O T I O N A L  A L I G N M E N T
 

A Better Way / Dignity for the Workers  
A Healthier and Safer World / American Made

E S S E N C E
 

Kaivac Means Clean

BR AND PYR AMID



BE PERSONAL
Use “I-you” and “we-you,” as if you’re talking 
to a neighbor, friend or colleague.

BUSINESS-Y:  

Kaivac offers comprehensive solutions to 
companies and industries.

PERSONAL:  

We offer comprehensive solutions to assist you 
in achieving healthy and safe facilities.

BUSINESS-Y:  

The customer should contact customer 
support with problems.

PERSONAL:   

Feel free to contact your customer solutions 
specialist 24/7/365.

USE EVERYDAY LANGUAGE
Take the point of view of your audience, using 
familiar words they’d use in conversation, 
allowing them to have the information simply, 
quickly and efficiently.

Use contractions because this is the natural 
way we talk and it appears more approachable 
and friendly.

BE ACTIVE
Use active voice and strong verbs whenever 
possible, avoiding passive “there is” and 
“there are” sentences

PASSIVE:  

Here are five Kaivac products that can provide 
a deeper, faster and more cost-effective clean.

ACTIVE:  

Implement these Kaivac products to achieve a 
deeper, faster and more cost-effective clean. 

HEADLINES
Begin with verbs or benefit words (i.e., how or 
why, or # ways or tips) whenever possible to 
grab attention and encourage action

VERB HEADLINE:   

Customers in store improves the bottom line.

BENEFIT HEADLINE:   

When customers stay longer in your store,  
they buy more.

Our Brand Voice — what we say  
and how we say it — is as much a 
part of our brand as our visual look 
and feel. It’s the tone and attitude 
behind every communication.

Our Voice connects with our audience on a human  
level. We speak with our audience, not up to them  
or down to them.

Our Voice is welcoming and approachable, clear and 
concise. We are always informative, respectful and kind. 
We understand that people are busy, so we’re mindful 
of their time.
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BR AND VOICE



VISUAL GUIDELINES



Using logos consistently creates 
strong brand recognition. The logo 
is the primary vehicle for visually 
expressing the brand. 

A / PRIMARY LOGO is horizontal and includes the logo 
mark coupled with the logo type.

B / SECONDARY LOGO is a stacked version of the logo 
mark and logo type. It is to be used in situations where 
horizontal space is at a premium. 

C / CLEAR SPACE ensures the logo is legible and 
prominently featured. Clear space must appear around 
the entire logo both vertically and horizontally equal to 
the 1/2 the height of the logo mark.

D / MINIMUM SIZE for the horizontal logo is .25" high. 
Minimum for the stacked logo is .5" high.

D / 

B / A / 

C / C / 

.25" .5"

X

1/2 X

1/2 X

1/2 X

1/2 X

1/2 X 1/2 X

1/2 X 1/2 X

X
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PRIMARY LOGO

Logo Mark Logo Type



A / Kaivac logo 
The Kaivac logo is created from the Primary 
Color Palette. Use this version when placing 
the logo on a White or Gold or light colored 
backgrounds.

B / Logo on a black or dark background 
The Logo Type and trademark become white 
and the remainder of the Logo Mark doesn’t 
change. 

C / When placing a logo over a photo, select 
a simple area so that the logo has plenty of 
clear space around it.

D / When budget limits color and the 2-color 
logos can’t be used, the logo can be used in 
a 1-color version using Black, Gold, or White 
from the Primary Color Palette.

A / 

D / 

B / 

C / 
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LIMITED COLOR LOGOS



Don’t use on a background  
that interferes with legibility

Do not use drop shadows  
or other design effects 

Don’t use on a busy background

Don’t change the color of the  
logo type or logo mark or  

use it in a non-approved color

Don’t remove the circle or change  
the K-check logo mark

Don’t change the font  
of the logo type

KAIVAC®

Don’t adjust the scale or positioning  
of the logo mark or logo type

Don’t skew, stretch or 
 distort the logo

Incorrect use of the Kaivac 
logo will compromise its 
integrity and effectiveness.

Although these examples don’t represent 
every misuse, they reflect situations to avoid.  
To ensure correct reproduction, always begin 
by reviewing these guidelines.
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LOGO DON’T



LOGO MARK may be used independent of the logo type as long as the full brand  
logo appears somewhere within the same execution. Solo use of the logo mark can  
be used on any media where space is limited or square, including on products and  
digital communication.

• The logo mark should be centered in the available space

• Minimum clear space around it that equals 1/2 its height 

• The logo mark should be used on its own in moderation

• The logo mark should have visual impact

Approval from Kaivac Marketing Department is required for this application.
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LOGO MARK



A brand’s color palette is a key 
component to its overall visual identity.

Proper use of the color palette helps to reinforce the 
brand’s equity, aids in brand identification and identifies 
the Kaivac brand more readily.

There are four colors in the primary palette. Ideally we  
want to promote the Kaivac Gold and Black in  
our communications as much as possible. 

Pantone 7408
CMYK  0 . 24 . 100 . 0
RGB  238 . 185 . 39
HEX  EEB927

KAIVAC GOLD

Pantone Black
CMYK  20 . 20 . 20 . 100
RGB  0 . 0 . 0
HEX  000000

KAIVAC BLACK

Pantone 422
CMYK  17 . 12 . 13 . 30
RGB  157 . 159 . 160
HEX  9D9FA0

KAIVAC GRAY

WHITE
CMYK  0 / 0 / 0 / 0
RGB  255 . 255 . 255
HEX  FFFFFF

WHITE
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PRIMARY COLOR PALET TE



The secondary color palette is a  
supplement to the primary palette and 
provides balance and visual interest. 

The secondary palette should not be used in place of our 
primary color palette, but rather to add a level of diversity 
to items such as charts, tables and infographics to highlight 
important information and help make content easier to scan.

These colors should be used rarely and sparingly.  
Under no circumstances should any of them become  
the predominant color for the Kaivac brand.

*  In certain instances, KAIVAC YELLOW (secondary color)  
can be used in place of KAIVAC GOLD for large color fields where 
greater contrast is needed between product/content. Please 
check with the marketing department to ensure useage  
is considered on brand.

Pantone 116
CMYK  0 . 16 . 100 . 0
RGB  255 . 210 . 0
HEX  FFD200

Pantone 131
CMYK  18 . 47 . 100 . 10
RGB  192 . 132 . 38
HEX  C08426

Pantone Cool Gray 10
CMYK  67 . 59 . 53 . 34
RGB  77 . 79 . 83
HEX  4D4F53

KAIVAC YELLOW*

KAIVAC BROWN

KAIVAC DARK GRAY

Pantone Cool Gray 3
CMYK  8 . 5 . 7 . 16
RGB  199 . 201 . 200
HEX  C7C9C8

KAIVAC LIGHT GRAY
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SECONDARY COLOR PALET TE



SOLEIL
Light 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Book 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Regular 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Semibold 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Bold 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Extra Bold 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

 
 
 
Book Italic 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Italic 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Semibold Italic 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Bold Italic 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

Extra Bold Italic 
abcdefghijklmnopqrstuvwxyz 0123456789 
abcdefghijklmnopqrstuvwxyz

In order to create and maintain a consistent look 
throughout all Kaivac materials, the same families and 
styles of typography should be used at all times.

SOLEIL is our primary typeface. We have chosen it for its clean and contemporary feel, 
and because its form is similar to the Kaivac logo type. Soleil has a broad range of 
weights allowing for design flexibility.  

ARIAL
Regular 
abcdefghijklmnopqrstuvwxyz 0123456789

Regular Italic 
abcdefghijklmnopqrstuvwxyz 0123456789

Bold 
abcdefghijklmnopqrstuvwxyz 0123456789

Bold Italic 
abcdefghijklmnopqrstuvwxyz 0123456789

Secondary Typeface.

ARIAL is the secondary typeface. It is an acceptable 
alternative in Microsoft applications, such as PowerPoint 
or Word. Don’t use this typeface for any other purpose.
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T YPOGR APHY



Typographic hierarchy cues readers  
to content importance on a page.

Use the type samples to the right as  
a starting point for branded materials.

SIZE AND WEIGHT RECOMMENDATIONS 
At the right, you’ll see recommended type sizes and leading 
for a typical marketing piece (such as a brochures, sell sheets 
or direct mail). 

There are additional notes about Body Copy and Bulleted 
Lists noted within the text  at the right.

ITALICS should not be used for headlines or subheads.  
It should only be used for emphasis in body copy or quotes.

COMMAS 
When listing multiple items in a sentence, don’t use  
a comma (also known as the Oxford comma) before “and.”

WIDOWS 
Keep at least two words on the last line of a paragraph  
to eliminate widows. 
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T YPOGR APHIC BEST PR AC TICES

HEADLINE  
GOES HERE
Subhead A

SUBHEAD B

This is the suggested Body Copy style. Please note that type 
size and leading can change proportionally based on the 
format and layout needs. Don’t use other typefaces other than 
Soleil, even if they fit thematically with your design. Body copy 
should be black, but can be 85% black instead of Kaivac Gray. 
Choosing black insures that only 1 ink (K, of CMYK) prints for 
the text and allows for sharper text appearance in most cases. 
This is especially true the smaller the text size.

• Bulleted List should only use the circle (command+8). 
Circle should only be between  70-100% of text size and be 
centered across from the text. In very rare instances, you can 
use a plus icon as a bullet.

• The text should be indented 9p or .125"

• Bullets can be color of text (or a brand color if appropriate)

• There should be a space after set so the bullets have  
visual separation

HEADLINE
Soleil Extrabold 

24pt. / 25 Leading 
+25 Tracking

RUNNING HEAD
Soleil Bold 
8pt. / 10 Leading

+200 Tracking

SUBHEAD A
Soleil Bold 

13pt. / 18 Leading

SUBHEAD B
Soleil Bold 
9pt. / 14 Leading

+50 Tracking

BODY COPY
Soleil Book 
9pt. / 14 Leading

BULLETED LIST
Soleil Book 
9pt. / 12 Leading 

6 pica Space After

R U N N I N G  H E A D



Imagery is powerful and a key 
component to bringing the 
essence of the Kaivac brand to life. 

Photography engages the audience through  
style, color and content. It also helps to reinforce 
brand messaging. 

Style 
Mid-level contrast 
and should be neutral 
with “pops” of color to 
complement the equipment 
and contrast between clean 
and dirty surfaces.

Perspective 
Unique cropping and 
perspectives used to 
focus on the people and 
the task which creates 
a focus the action and 
equipment. 

Talent 
Represent an audience 
diverse in race, gender 
and age. Expressions 
should be genuine.

Safety equipment 
Safety is important and 
should be addressed in 
imagery when applicable.
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LIFEST YLE 
PHOTOGR APHY



Imagery is powerful and key 
component to bringing the  
Kaivac product line to life. 

A / WHITE BACKGROUND PHOTOGRAPHY

• Allow for clear focus on the product and its details

• Promotes consistency among all products

• Use of realistic ground shadows

• Photos of product should be taken at multiple angles 
to communicate size, texture and key features

B / LIFESTYLE AND CONTEXTUAL PHOTOGRAPHY 

• Allow for clear focus on the product and its details

• Shows the context of use

B / 

A / 
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PRODUC T 
PHOTOGR APHY



147º / 33º

Angle is based off of the check mark in the logo mark.

A Smarter Clean.
KAIVAC® CLEANING SYSTEMS FOR GROCERY STORES

A N G L E S

The angle for Kaivac is based on the  
check mark in the K-Check logo mark.

• Angles 1470 / 330

• Must be run vertically in upward direction, in the 
same orientation on the “check mark” in logo

• The angle is used to create the triangle corners 
that can appear in page design

D U O T O N E S

Duotones can visually enrich the brand,  
adding depth and sophistication.

• You can create a duotone by using the Kaivac Gold  
from the Kaivac Primary Color Palette over a  
black/white image.

• Contrast of the monochromatic can be adjusted 
based on the photography selected.

Steps for Creating a Duotone: 

• Convert Image to Grayscale

• Image>Mode>Duotone>Type>Monotone>PMS 131 
(Adjust Levels/Curves as needed)

• Convert to CMYK>New Layer>Adjustment 
Layer>Solid Color (PMS 7408)>Set to Multiply
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GR APHIC ELEMENTS



Icons are a highly effective 
way to quickly convey ideas  
or navigate content.

• Icons are a combination simple geometric  
linework, subtle rounded corners and 
rounded end caps.

• Icons may appear as either positive  
or negative, however the Icons must appear 
as a single Kaivac primary color.

• The icon library may continue to grow to 
match business and communication needs.

• DON’T create your own icons without 
checking with the Kaivac marketing dept.

Refrigeration

Healthcare

Spills

Industrial

Specialty Area

Retail

Ineffective 
Cleaning 
Methods

Fitness
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ICONOGR APHY

Restrooms

Education

Cafeteria No Touch BatterySports Corded



BRAND IN ACTION



StationeryPowerPoint
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CORPOR ATE MATERIAL S

SUBHEAD

HEADLINE
SUBHEAD

HEADLINE

SUBHEAD HERE

DIVIDER SLIDE
SUBHEAD HERE

DIVIDER SLIDE

PROPER CARE EQUIPMENT
K A I V A C  C L E A N I N G  S Y S T E M S

KAIVAC®
PRODUCT
Lorem ipsum 
dolo sit amet, 
tempor ctetur
adipiscing elit
sed do quis.

KAIVAC®
PRODUCT
Lorem ipsum 
dolo sit amet, 
tempor ctetur
adipiscing elit
sed do quis.

KAIVAC®
PRODUCT
Lorem ipsum 
dolo sit amet, 
tempor ctetur
adipiscing elit
sed do quis.

KAIVAC®
PRODUCT
Lorem ipsum 
dolo sit amet, 
tempor ctetur
adipiscing elit
sed do quis.

Combines chemical injection, high-pressure rinse, and vacuum recovery to an integrated 
system. Originally designed for the restroom, but now available throughout the building.

WHAT IS NO-TOUCH CLEANING?
K A I V A C  C L E A N I N G  S Y S T E M S

321

800-287-1136

2680 Van Hook Avenue, Hamilton, OH 45015

2680 Van Hook Avenue
Hamilton, OH 45015

kaivac.com

TIM ADKINS
 DIRECTOR OF KEY ACCOUNTS

 330-206-9688
 tadkins@kaivac.com



A Smarter Clean.
KAIVAC® CLEANING SYSTEMS FOR GROCERY STORES

Clean is Good 
for Business.

You’ve innovated in every part of your 
grocery business. Now, if only there were 
an innovative way to clean it. There is. 

Welcome to Kaivac®.

At Kaivac, there’s nothing magical about 
clean. We simply think common cleaning 
problems all the way through, by putting 
ourselves in the shoes of the worker. Then 
we create and test science-based, worker-
friendly solutions that measurably deliver 
maximum results with minimum effort 
while remaining cost-effective — all while 
protecting the worker.

That’s how we approach everything we do.  
And it’s why we say, “Don’t just clean it, 
KAIVAC it.”

RESTROOMS

You might think keeping restrooms clean and  
comfortable is simply a convenience you provide for 
shoppers. Turns out, it’s much bigger than that. Unkept 
restrooms can directly impede profits, cast doubt on 
food safety, harm your store’s reputation on social 
media, and ultimately lose customers.

•  Clean restrooms encourage customers to shop 
 longer, which equates to more purchases

•   Dirty restrooms drive customers away –  
permanently. A Harris Interactive study shows  
50% of customers wouldn’t return to a grocery  
store with dirty restrooms

•   Remember, customers often complain on social 
media before visiting a store’s customer service desk

SPILLS

Spills are more than just an annoyance. They take 
employees away from productive tasks. They create 
traffic jams, slow shoppers down and prevent them 
from reaching the products they seek. Worse yet, 
they present a massive slip-and-fall liability. And 
every spill is different with no one way to clean,  
and some are actually dangerous to handle.

•  According to Lawyers.com, average settlements 
 for slip-and-fall injuries range between $17,200 
 and $27,500

•  Floors remain wet for a dangerously long time

•  Hazard signs are actually a tripping hazard

REFRIGERATION

What you don’t know can and is hurting you. Lurking 
beneath the surface of your cooler and freezer cases 
are clogged coils that increase power consumption 
and wear out components faster. And those frequent 
unpleasant odors? They’re caused by catch basins 
collecting pools of stagnant liquid, bio-film and lost 
rotting product that threaten food safety. Often, the 
drains of these basins back up and spill onto the floor.

Clogged coils make the machinery:

•  Work harder

•  Wear out faster

•  Use more power

 
Foul-smelling pools in catch basins accumulate:

•  Stagnant liquids and bio-film

•  Bacteria

•  Food drippings, packaging, price tags  
 and other debris

Air cycles over these pools and directly onto  
displayed products, posing risks to food safety.

Grocery Store Cleaning:  
A Bigger Challenge than You Think
You know grocery store cleaning presents unique challenges.  
Keeping a clean, safe and inviting store is incredibly demanding, 
but absolutely necessary. From customer impressions to food safety, 
cleanliness in the grocery business is a key component in customer 
loyalty, reputation and profitability. 

INEFFECTIVE CLEANING METHODS

None of these issues are new but managers 
and workers to this day are faced with an 
incredibly poor range of equipment and 
processes to address them.

Mops actually:

• Just spread soils, contaminants 
 and grease around

• Remove very little

• Involve a painfully slow process

 
Autoscrubbers are:

• Expensive

•  Difficult to maintain

•  Hard to operate

•  Can be unsafe around customers

SPECIALTY AREAS

Deli, Food Court, Butcher & Seafood, Bakery  
and  others. These all represent special cleaning 
challenges that directly affect customer and 
employee safety. Many have greases and food  
by-products that accumulate on floors, create  
slip-and-fall hazards and are often in tight  
working areas that make cleaning difficult.

Grease, food and other matter  
that accumulates on floors:

•  Meat trimmings

•  Cooking grease

•  Food spills

•  Dry baking ingredients

HELP!
With all these known issues, 
you’re probably starting to 
wonder why nobody out there 
is really focused on developing 
cleaning systems designed  
especially for grocery. 
Now there is…

K A I VA C ®  C O O L E R  C A S E  C L E A N E R

What if there were a fast, easy and touchless way to clean the internal basins 
and coils of refrigerated display cases? Too good to be true? Think again.  
The Kaivac Cooler Case Cleaner is designed especially for this unique  
grocery industry cleaning task.

Just pull the case’s base panels, vacuum all the liquid and debris out of the catch basin, blast 
contaminants and dust out of the coils and the basin with the spray wand, and… DONE. It’s truly 
that simple. Refrigeration cases are left clean and efficient, eliminating odor, protecting expensive 
product, reducing power bills, and prolonging the life of the case.

Kind of a no-brainer, right?

REFRIGERATION

Brochure
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CUSTOMER COLL ATER AL



A Cooler Clean.

KAIVAC® COOLER CASE CLEANER

K A I VA C ®  C O O L E R  C A S E  C L E A N E R

What if there were a fast, easy and touchless way to clean the internal basins  
and coils of refrigerated display cases? Too good to be true? Think again.  
The Kaivac Cooler Case Cleaner is designed especially for this unique grocery 
industry cleaning task.

Just pull the case’s base panels, vacuum all the liquid and debris out of the catch basin, blast contaminants 
and dust out of the coils and the basin with the spray wand, and… DONE. It’s truly that simple. Refrigeration 
cases are left clean and efficient, eliminating odor, protecting expensive product, reducing power bills,  
and prolonging the life of the case.

Kind of a no-brainer, right?

REFRIGERATION

SEE THE KAIVAC COOLER 
CASE CLEANER IN ACTION

  FEATURES + BENEFITS
+  Proper case temperature reduces 

product spoilage and waste while 
protecting customers from  
foodborne illness

+  Clean coils not only help improve 
energy efficiency by 35% or more, 
they also extend the life of the cooler

+  Clean coolers eliminate a primary 
cause  of unnecessary and costly 
service calls

+  Sanitary appearance and conditions 
increase customer satisfaction and 
purchases

+  Increased productivity over other 
methods — 50% or better

+  The integration of pressure washing 
and vacuum extraction provide 
unrivaled soil and odor removal

+  The simple system is easy to learn  
and worker friendly

+  Hygienic cleaning capability reduces 
the risk of illness or outbreak from 
biological contamination

 

KAIVAC COOLER 
CASE CLEANER
Kaivac’s Cooler Case Cleaner offers a simple, effective 
solution for successful maintenance of your commercial 
refrigeration units. With a specially designed built-in 
indoor pressure washer and a powerful wet vacuum, 
you can achieve clean, safe and odor-free coolers 
operating at peak efficiency in less than half the time  
of conventional cleaning methods.

17-GALLON RETENTION TANK

Holds 17 gallons of soiled water 
in upper tank. Easy-access port  
combined with quick-flush  
dump hose simplifies emptying  
and cleaning of tank.

INSTANT DRAIN

Attaches to vacuum hose and 
suctions to floor to extract 
low-lying moisture creating a 
vacuum-powered floor drain.

KAITUTOR™

Video training system 
leads the operator through 

the cleaning process.

15-FT. SPRAY HOSE &  
ERGONOMIC WAND

Spray pressure is delicate  
enough to use on condenser  
fins but powerful enough to 

clean heavily-soiled areas.

VACUUM WAND

Sturdy, one-piece wand made 
of aircraft aluminum for  
cleaning multi-surface floors.

LARGE-CAPACITY 
CLEAN-WATER TANK

Holds nearly 20 gallons of  
hot water. Tank can be filled  
with multi-faucet fill hose  
or easy-access fill port.

Protected by multiple US patents. Multiple patents pending.

LITHIUM-ION BATTERY (OPTIONAL)
Allows free and quick movement at any 
time of the day throughout the facility.

GFCI POWER CORD (25 FT.)
Allows the user to cover extensive areas by 
unwrapping length ofpower cord as needed.

FLEXIBLE 
POWER OPTIONS

See kaivac.com for more information and complete specifications.

Save time. Save money.  
Build your business with the power of clean. 

Call Kaivac today for a free consultation at 800-287-1136 
or visit us online at kaivac.com

© Copyright Kaivac, Inc. 2020  Protected by multiple US patents. Multiple patents pending. KGB12182020

2680 Van Hook Avenue, Hamilton, Ohio 45015
P: 513-887-4600   F: 513-896-8548   info@kaivac.com

Product Sales Sheet
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CUSTOMER COLL ATER AL
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WEBSITE

FPO


